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Abstract

Insulin resistance in key target organs and beta cell dysfunction due to gluco- and
lipotoxicity, are the two main factors driving type 2 diabetes mellitus pathogenesis.
Recently, it has been suggested that ectopic fat deposition in the pancreas, named
non-alcoholic fatty pancreas disease, occurs in metabolic syndrome, and may play
an etiological role in islet dysfunction and damage the exocrine pancreas, increasing
its susceptibility to pancreatitis and pancreatic cancer. In this chapter, we present
transmission electron microscopy (TEM) as a valuable method to detect early changes
in the ultrastructure of pancreatic cells during the development of the metabolic
syndrome in mice fed with a western diet (WD). Mice fed with a WD develop patho-
logical ultrastructural alterations in the exocrine and endocrine cells. We demonstrate
how to use image segmentation methods and ultrastructural morphometry to analyze
and quantify structural changes in cellular organelles and evaluate the presence of
lipid droplets, autophagic structures, and vacuolization. Since ultrastructural lesions
can be detected early during the progression of the metabolic syndrome, are in many
aspects subtle, and by far precede cell apoptosis, necrosis, fat infiltration, and overt
functional changes, TEM is not only a suitable but probably the crucial method for
detecting early pancreas dysfunction.

Keywords: pancreas physiology, exocrine cells, endocrine cells, ultrastructure,
metabolic syndrome, type 2 diabetes mellitus, western diet

1. Introduction

The number of people with type 2 diabetes mellitus (T2DM) is growing rapidly
worldwide and has already exceeded 530 million in 2021 [1]. Because of the severe
consequences of T2DM for patients and the enormous burden on the healthcare
system, a lot of research is focused on understanding the development of T2DM.
The healthy pancreatic beta cells secrete insulin at a basal rate throughout the day
and increase secretion in response to stimulation with nutrients, especially glucose,
and other neurohormonal secretagogues, such as acetylcholine and GLP-1, after a
meal [2-4]. Understanding the pathophysiology of early phases of glucose tolerance
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disruption associated with morphological and functional beta cell changes present

in insulin-resistant people susceptible to the development of T2DM is especially
important and has been the focus of many research groups [5-9]. However, to date
very limited information is available about the ultrastructural alterations of beta cells
during the early stages of T2DM development [10-13].

Thus, the aim of our chapter is to present the importance and illustrate the useful-
ness of transmission electron microscopy (TEM) in the research field of pancreas
physiology through specific and easily reproducible examples. TEM is a technique
used to obtain ultrahigh-resolution images of different samples. The prototype of the
transmission electron microscope was developed by Ernst Ruska and Max Knoll in
1931. Since then, TEM has been extensively used in biomedical research, helping us
deepen our knowledge about the ultrastructure of cells and understanding the cellular
processes. TEM was first used to identify specific features of pancreatic endocrine
and exocrine cells in the mid-1950s by Paul Lacy [14] and George Palade [15], respec-
tively. TEM exploits the wavelength properties of electrons to provide greater spatial
resolution than the resolution achieved using photons in light microscopy (LM). In
TEM, a beam of high-voltage electrons is emitted by the electron gun and then passed
through the sample. The most challenging part of TEM is the preparation of samples
that are thin and robust enough to allow electrons to penetrate the sample on the one
hand and survive the damage caused by the electron beam on the other. In this chap-
ter, TEM is implemented as an appropriate research method that allows us to detect
very subtle structural changes in pancreas cells of mice fed with a western diet (WD).
Here, we focus on sample preparation, microscopy, and quantitative analysis of
ultrastructure, together with some representative results, to illustrate the utility and
emphasize the importance of TEM in pancreas research. A comprehensive analysis of
ultrastructural changes in WD-fed mice with partly compensated diabetes mellitus
will be present in detail elsewhere.

In the first part of this chapter, we briefly summarize the basic anatomical features
of the pancreas in humans and mice and describe the main physiological character-
istics of the endocrine and exocrine pancreas. Next, we describe the development
of T2DM, focusing on the role of obesity and key pathophysiological events. In the
central part of this chapter, we discuss the ultrastructural morphology and describe
the methodology used for ultrastructural morphometry of the exocrine and endo-
crine pancreas during the early stages of WD-induced T2DM development.

2. Structure and function of the pancreas

The pancreas is an unpaired gland of the alimentary tract with two different but
complementary functions: the production of digestive enzymes and alkaline fluid in
exocrine cells that help with the breakdown of energy-rich nutrients and the synthesis
by endocrine cells of hormones needed to control the storage and usage of energy-rich
nutrients [16]. In humans, the pancreas is a well-defined organ with three major parts:
the head, the body, and the tail, extending from the duodenum to the spleen [17, 18]. In
mice, the pancreas is not as well-defined as in humans but is rather diffusely distrib-
uted in a dendritic manner while it is still composed of three major parts: the duodenal
lobe, the largest splenic lobe, and the smallest gastric lobe [19]. A fibrous capsule
surrounds the pancreas, and the connective tissue extending into the gland divides the
parenchyma into larger lobes and smaller lobules [18, 20]. Each lobule is composed of
acini that consists of pyramid-shaped acinar cells [21]. The exocrine part accounts for
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96-99% and the endocrine islets of Langerhans for the remaining 1-4% of total pan-
creas parenchyma [22, 23]. In mice, the islets are mainly interlobular, while in humans
they are usually intralobular, mostly on the edge of lobules [24, 25]. Despite some
differences [26], islets of Langerhans from mice and men possess many structural and
functional similarities [27, 28]. They are round to oval, vary in size, and range from
a few to several thousand endocrine cells. Importantly, the islet size distributions are
similar in humans and mice (and also many other species) [22]. At least five different
types of endocrine cells can be found in islets in both species [27]. Most numerous are
the beta cells that synthesize and secrete insulin. Alpha cells secrete glucagon, while
delta cells and PP cells release somatostatin and pancreatic polypeptide, respectively.
Finally, epsilon cells are the least abundant, synthesizing and secreting ghrelin [23-25].
As mentioned above, the exocrine pancreas plays a crucial role in the enzymatic
digestion of carbohydrates, proteins, and lipids and secretes a bicarbonate-rich fluid
[29-31]. The enzymes are stored in an inactive proenzyme form in the so-called
zymogene granules located at the apical membrane of acinar cells and are released
in response to stimulation by neurohormonal secretagogues, such as acetylcholine
and cholecystokinin, via exocytosis. The fusion of granules with the apical plasma
membrane releases the enzymes first into the acinar lumen, from where they pass via
the ductal tree into the small intestine [32]. In contrast, islets release their hormones
into the numerous islet blood capillaries that drain into the portal venous system. In
the liver and other key target tissues, such as the skeletal muscle and adipose tissue,
insulin acts as a key anabolic hormone, promoting glycogenesis, glycolysis, lipogen-
esis, and proteinogenesis, and suppressing gluconeogenesis, lipolysis, and proteolysis
[33-35]. On the other hand, glucagon acts mainly in the liver, where it promotes
glycogenolysis and gluconeogenesis, and inhibits glycolysis and glycogenesis [36, 37].

3. The role of obesity in the development of type 2 diabetes

The decrease in insulin action indicates insulin resistance, the main hallmark of
T2DM [38]. Several factors play a role in the development of insulin resistance, with
obesity probably being the most important one [39]. During the last three decades,
obesity has reached an epidemic stage in all age groups [40]. Increased intake of
energy-dense foods containing a high percentage of fat and carbohydrates, combined
with a lack of physical activity, leads to a net positive energy balance and represents
the primary cause of obesity. The first stages of obesity are hypertrophy and hyper-
plasia, where adipocytes try to meet the demand to store excessive energy. When
levels of free fatty acids and triglycerides exceed the metabolic capacity of adipose
tissue, they accumulate as ectopic fat in non-adipose tissue such as the liver, pancreas,
skeletal muscles, and heart [41]. The regional distribution of adipose tissue is par-
ticularly important for the development of disorders of glucose and lipid metabolism
[42, 43]. The fat infiltration in the liver and pancreas in the absence of excess alcohol
intake is termed non-alcoholic fatty liver disease (NAFLD) and non-alcoholic fatty
pancreas disease (NAFPD), respectively [44]. Due to fat accumulation in hepatocytes,
NAFLD leads to inflammation, fibrosis, cirrhosis, and liver cancer and critically
affects insulin sensitivity in the liver [44-46]. NAFPD plays a similar role in the
dysfunction of the endocrine and exocrine pancreas leading to exacerbation of acute
pancreatitis and increasing the susceptibility to pancreatic cancer [46-50]. Although
the concept of the NAFPD was introduced only a few years ago [51], the correlation
between fat infiltration and pancreas was first described almost a century ago on
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obese cadavers having larger pancreata compared to non-obese cadavers [52, 53].
Importantly, over the last decade, it has been demonstrated convincingly that most
of the morphological, functional, and clinical features of T2DM are reversible with
sufficient weight loss and that these positive changes depend on the level of hepatic
and pancreatic fat reduction [54-56].

Although insulin resistance is one of the main features of T2DM, it is not sufficient for
the development of T2DM. Despite increasing insulin resistance, present long before the
onset of diabetes, individuals with preserved beta cell capacity can stay normoglycemic
for several years due to compensatory insulin hypersecretion. Furthermore, a certain
proportion of individuals with insulin resistance never develop T2DM. The idea has been
put forward that there may be a personal fat threshold or an individual level of suscepti-
bility to developing T2DM at a given body mass index, with the main mechanisms behind
this attractive hypothesis being varying degrees of fat accumulation in the liver and the
pancreas, together with varying individual responses to this accumulation [57]. An obese
subject with insulin resistance can secrete 2-5 times more insulin compared to lean non-
diabetic individuals in response to a glycemic load, but when the adaptive capacity of the
beta cells fails, T2DM occurs [58]. Several studies have shown that the first phase of insu-
lin secretion is primarily affected, resulting in impaired glucose tolerance. During the pro-
gression of T2DM, the second phase of insulin secretion is further lost. Post-translational
defects in insulin synthesis also occur, resulting in increased proinsulin secretion, and by
the time the diagnosis of T2DM is made, the beta cell function is already typically reduced
by 80% [59]. This beta cell failure is responsible for transitioning from an insulin-resistant
compensated state to overt T2DM and remains to be elucidated in details. It probably
involves an initially inadequate beta cell mass and an insufficiently increased response of
the existing beta cells to increased insulin demand [60]. Noteworthy, the susceptibility of
beta cells themselves to developing insulin resistance may play an important pathophysi-
ological role [61]. Individuals with T2DM can display changes in beta cell mass, either
due to a decrease in beta cell proliferation or/and an increase in cell apoptosis [62]. In
T2DM patients, the apoptosis rate is increased severalfold compared to normoglycemic
individuals [63], a phenomenon confirmed by ultrastructural analysis using TEM [64].
Furthermore, during T2DM gradual dedifferentiation of beta cells occurs in animal
models, while the role of dedifferentiation during the development of human T2DM is
controversial and less well-studied [63, 65-68]. Chronic exposure of islets to elevated
levels of glucose, fatty acids, and amino acids results in ER stress due to increased insulin
synthesis and secretion [69]. The protein folding capacity of ER becomes exceeded, which
leads to the activation of the so-called unfolded protein response (UPR) and consequently
to the inhibition of protein translation [70, 71]. Gluco- and lipotoxicity cause a vicious
cycle of continuous deterioration of the glucometabolic state and eventually impair
insulin secretion and increase apoptosis. In T2DM, not only the islet cells are affected, but
also the pancreatic acinar cell viability and growth decrease, leading to increased apopto-
sis and replacement by fat [72, 73]. Importantly, intracellular fat in acinar cells may affect
beta cell function in a paracrine manner through the release of adipokines. It is also likely
to play a role in pancreatic carcinogenesis, seems to be associated with changes in innerva-
tion, and may initiate an acinar-to-adipocyte trans-differentiation [56].

4. Application of TEM in pancreas physiology

Glucose-induced insulin secretion is based on oxidative metabolism, thus mitochon-
drial function is of crucial importance for beta cells [74]. Mutations in mitochondrial
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DNA result in reduced insulin secretion and hyperglycemia [75]. The genetic back-
ground is not the only factor affecting mitochondrial function. The diabetic environ-
ment, with chronic hyperglycemia, can also affect mitochondria [76]. Such a milieu
could be responsible for the progression of T2DM and the reduced capacity of insulin
release in these patients. Mitochondria appear round-shaped and hypertrophic in
endocrine cells from T2DM islets [76-78]. Besides mitochondria, the structure of other
cellular organelles is also altered [79]. The volume density of the endoplasmic reticulum
is typically increased, and autophagic vacuoles are present [78, 80, 81]. TEM isalso a
very useful technique that enables us to identify apoptotic cells [82].

Several studies showed that TEM is suitable to detect morphological characteris-
tics of the diabetic pancreas, but only a few studies have reported results in quantita-
tive terms. Due to the large variability and plasticity of cells and their organelles,
especially mitochondria, qualitative evaluations are not sufficient [83]. Furthermore,
quantitative morphometry is needed to evaluate subtle structural changes early
during the progression of the metabolic syndrome that may precede overt functional
changes occurring during the development of T2DM.

Since mouse models of T2DM exhibit comparable developmental features and can
provide significant insight into the mechanisms of T2DM development in humans
[84], they are widely used in these studies. From several animal models, C57Bl/6 ] mice
have been the most susceptible to the development of the metabolic syndrome and
diet-induced diabetes [85-89]. We performed the morphological and morphometric
evaluation of pancreatic endocrine and exocrine tissue obtained from C57Bl/6] mice
fed with control diet (CD) or western diet (WD). During 8 weeks on WD, these mice
developed obesity, hyperglycemia, and hyperinsulinemia (data not shown). Pancreatic
tissue samples were taken in parallel with the preparation of acute pancreas tissue slices
intended for electrophysiological studies, confocal calcium imaging, and expression
analyses. Although the functional response to glucose in terms of intracellular calcium
concentration changes and sensitivity of the exocytotic machinery to calcium were well
preserved in WD mice (data not shown), TEM revealed severe morphological changes
in the endocrine and exocrine part of the pancreas. In the following section, we
demonstrate how to use image segmentation methods and ultrastructural morphom-
etry to analyze and quantify structural changes in the rough endoplasmic reticulum,
mitochondria, and exocytotic vesicles and vacuolization in the endocrine and endo-
crine part of the pancreas from control animals and animals fed with WD. These
ultrastructural lesions presented below can be detected early during the progression of
the metabolic syndrome and precede cell apoptosis, necrosis, fat infiltration, and overt
functional changes. Therefore, TEM enables a more direct assessment of the functional
characteristics of the pancreatic tissue and is therefore a suitable and probably the
crucial method for detecting alterations associated with early pancreas dysfunction.

5. Sample preparation and analysis
5.1 Ethical statement

The study protocol was approved by the Administration for Food Safety, Veterinary
Sector and Plant Protection, Ministry of agriculture, Forestry and Food Republic of
Slovenia (approval number: U34401-12/2015/3). The study was conducted in strict
accordance with all national and European recommendations pertaining to care and
work with laboratory animals, and every effort was made to minimize animal suffering.
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5.2 Animals, tissue preparation, light, and transmission electron microscopy

Experiments were performed on 20-22-week-old male C57BL/6 ] (RRID: IMSR_
JAX:000664) mice purchased from Charles River (Figure 1A). Upon weaning, mice
were fed with a standard rodent diet (CD, R70, Lantmannen, Stockholm, Sweden)
with 72% of kcal from carbohydrates, 10% from fat, and 18% from protein until
12 weeks of age. From 12 to 20 weeks of age, a control group continued to be fed with
CD while the second group was fed with WD (D12079B, Research diets inc., New
Jersey, USA) containing 43% kcal from carbohydrates, 40% from fats and 17% from
proteins (Figure 1B). Water was available ad libitum. Mice were housed in individu-
ally ventilated cages (Allentown LLC, USA) in groups of 1-4 animals per cage at
20-24°C, 45-65% relative humidity, and a 12-hour day-night lighting cycle. The bright
part of the cycle was between 7 pm and 7 am. Mice were weighed before sacrifice.

Acute pancreas tissue slices from CD and WD mice were prepared as described
previously [90-92]. For light microscopy (LM) and transmission electron microscopy
(TEM), a small piece of the pancreatic splenic lobe was clamped using hemostatic
forceps to avoid the leakage of agarose into this part of the pancreas. After removal from
the body, small fragments of the pancreas were fixed in 2.45% glutaraldehyde and 2.45%
paraformaldehyde in a 0.1M sodium cacodylate buffer (pH 7.4) at room temperature
for 3 h, and at 4°C for 12 h. The tissue was washed in a 0.1 M sodium cacodylate buffer
(pH 7.4) at room temperature for 4 h and post-fixed with 2% OsO4 at room temperature
for 2 h. After washing in a 0.1 M sodium cacodylate buffer (pH 7.4) at room temperature
for 3 hours, the tissue was dehydrated in a graded series of ethanol (50%, 70%, 90%,
96%, and 100%, each for 30 minutes at room temperature). The pieces of the tissue were
embedded in TAAB embedding resin (Agar Scientific Ltd., Essex, England). For LM,
semithin sections (2 pm) were stained with 0.5% toluidine blue in an aqueous solution.
For TEM, ultrathin sections (70-75 nm) of the tissue were stained with uranyl acetate
and lead citrate and analyzed with a Zeiss EM 902 transmission electron microscope.

5.3 Structure of the exocrine and endocrine pancreas
5.3.1 Qualitative analysis of exocrine and endocrine cell ultrastructure

The pancreas is composed of exocrine and endocrine tissue and this functional
specialization can readily be recognized microscopically (Figure 2).
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Figure 1.
Study design (A) timeline of the study. The part of the project shown in yellow is presented in this chapter.
(B) Energy profile of control diet (CD) and western diet (WD).
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Figure 2.

Mice ave fed with control diet (CD). (A) and (B) Semithin sections of the pancreas. (A) Exocrine part of

the pancreas is composed of acinar cells (one cell marked by the yellow dotted line), organized in acini (one
acinus marked by the green dotted line) and lobules (one lobule marked by the red dotted line). (B) Endocrine
cells forming a Langerhans islet are seen as brighter stained cells (ved dotted line). (C-F) Ultrathin sections

of the pancreas. (C) Exocrine cells are easily vecognized by their large size, typical shape, by abundant rough
endoplasmic veticulum, and secretory granules. (D) The majority of secretory granules are found in the apical
part of the cell. (E) and (F) endocrine cells can be distinguished by the fine structure and size of their secretory
granules. In all endocrine cells, well-developed rough endoplasmic reticulum, Golgi apparatus, and numerous
mitochondria are seen. AC, acinar cell; a, alpha cell; p, beta cell; 6, delta cell; D, duct; IL, islet of Langerhans;
GA, Golgi apparatus; M, mitochondrion; N, nucleus; nu, nucleolus; RER, rough endoplasmic reticulum; SG,
secretory granules. Scale bavs: (A) and (B) 50 pm; (C) 2.5 pm; (D) 2 pym; (E) 5 pm; (F) 2.5 pm.
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5.3.1.1 Novmal exocrine and endocrine cell ultvastructure

The majority of tissue consists of pyramid-shaped exocrine cells (Figure 2A-C).
These cells form clusters or acini around small ducts and are organized in lobes with
thin fibrous tissue. The exocrine cells produce inactive digestive enzymes, seen in the
cytoplasm packed in secretory vesicles (Figure 2C and D), and secrete them into the
intercalated ducts which they surround (Figure 2D). In each acinus, the exocrine cells
are located around the intercalated ducts, with their narrow apical parts oriented to the
duct (Figure 2C and D). The exocrine cells have a round or oval nucleus (Figure 2C),
located basally. The most prominent structure of the exocrine cells is the rough endoplas-
mic reticulum (Figure 2C) which is present in all different parts of the cell. Numerous
round electron-dense secretory vesicles are seen in the perinuclear and apical cytoplasm
(Figure 2C and D). The oval mitochondria (Figure 2C and D) are found in different
parts of the cell.

The endocrine cells are distributed throughout the pancreas (Figure 2B) as
interlobular positioned clusters of cells termed islets of Langerhans. In the islets of
Langerhans (Figure 2B) alpha, beta and delta cells can be distinguished (Figure 2E
and F). They are characterized by numerous secretory vesicles. Glucagon granules of
alpha cells are large dense-core vesicles and some of them have a pale halo. The core
of the granule is of a similar diameter to insulin granules, but the whole granule is
smaller by at least 50% (200 nm vs. 350 nm). Insulin-containing vesicles in beta cells
are the largest with large clear peripheral halos. Somatostatin-containing granules of
delta cells in mice are the smallest and lozenge-shaped (Figure 2E and F) [93-96]. In
the cytoplasm of all types of endocrine cells, abundant rough endoplasmic reticulum,
Golgi apparatus, and many oval mitochondria are present (Figure 2E and F) [97].

5.3.1.2 Ultrastructural changes in WD mice

Comparing the ultrastructure of pancreatic cells in control mice (CD; Figure 2) and
mice fed the western diet (WD; Figures 3A and B, 4B, 5E, 7E, and 8D), we observed
many important differences. In the exocrine pancreas of WD mice many necrotic cells
(Figures 3A and 4B) are present. In some acinar cells, lipid droplets are seen in the

Figure 3.

Mice are fed with western diet (WD). (A) and (B) Ultrathin sections of the pancreas. (A) A necvotic acinar

cell containing a lipid droplet in the cytoplasm. (B) Autophagosomes and autolysosomes in the cytoplasm of an
acinar cell. AL, autolysosome; AP, autophagosome; L, lipid droplet; M, mitochondrion; N, nucleus; SG, secretory
granules; RER, rough endoplasmic veticulum. Scale bars: (A) 2 ym; (B) 500 nm.
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cytoplasm (Figure 3A). In many cells, numerous autophagic structures, i.e., autopha-
gosomes, autolysosomes (Figure 3B), and residual bodies are found. The mitochondria
(Figure 4B) and rough endoplasmic reticulum (Figure 5E) seem to be disorganized,
therefore these structures were analyzed in detail.

The structure of the islets of Langerhans in mice fed by WD is non-compact,
inhomogeneous, containing more extracellular spaces than in mice fed by CD. There
are many necrotic cells in different parts of the islets. In the cytoplasm of endocrine
cells, some lipid droplets and many autophagic structures, i.e., autophagosomes,
autolysosomes, and residual bodies can be found. Structural differences are also seen
in the mitochondria and rough endoplasmic reticulum.

5.3.2 Quantitative analysis of selected cellular structures

Structural characteristics of mitochondria, rough endoplasmic reticulum, zymo-
gen granules, and vacuoles were studied. To accurately analyze various cell com-
pounds, it is necessary to select TEM images taken at the same magnification.

5.3.2.1 Analysis of mitochondria

Since mitochondria are crucial for normal beta cell stimulus-secretion coupling
and their ultrastructure is altered during the development of T2DM, we analyzed
them in more detail. First, we outlined all the mitochondria in the visual field and
calculated the surface area in nm” To quantitatively assess the condition of mitochon-
dria, we measured the following shape descriptors: circularity, roundness, aspect ratio
of the best fit ellipse, and solidity using Fiji software (NIH) [98].

Circularity (C) is a shape parameter that can mathematically indicate the degree
of similarity to a perfect circle. A value of 1.0 indicates a perfect circle. When the
circularity value approaches 0.0, the shape becomes less and less circular. Circularity
is defined by the equation

A
A

10000 =
| major axis

[

<2
O
D
O
O

O 0‘33 0.67
Roundness

Figure 4.

Shape descriptors. (A) Circularity versus roundness. (B) Sketch of a mitochondrion (gray) with an overlay of the
best fit ellipse (yellow), the major axis of the best fit ellipse (blue), and the minor axis of the best fit ellipse (ved).
The major axis is used in determining roundness (Eq. (2)) and aspect vatio (Eq. (3)). (C), the shape area (gray,
left) and the convex hull area (yellow, right) are used to determine the solidity.
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Analysis of the mitochondria from a CD and a WD mouse. Labeled mitochondria in the image of the exocrine
pancreas from the (A) CD and (B) WD mouse. Analysis of the (C) surface area, (D) circularity, (E) roundness,
(F) aspect ratio and (G) solidity of an image from CD and WD mouse. Data were pooled from the following
number of ROIs from the CD/WD image: 14/16. Data were analyzed using the Mann—Whitney U test, p values
are indicated on graphs.
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is similar to circularity, but it is insensitive to irregular borders along the
perimeter of the mitochondria and takes into account the major axis of the best fit
ellipse. For an illustrative explanation of the differences between circularity and
roundness, see Figure 6A.

From the best fit ellipse fit to each mitochondrion, the major and minor axes were
determined, and the aspect ratio (AR) was calculated by the following equation:

AR=—Z ©

minor axis

AR measures the ratio of an object’s height to its width (Figure 6B). Therefore,
the aspect ratio is equal to one for a perfect circle and increases with an increase in

deformation.
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RER AREA:

CD: 18 %

WD: 42 %

Figure 6.

Quantitative analysis of the RER. Representative TEM images from a CD (A) and a WD (E) mouse. The
quantification pipeline involves segmentation (B and F), a binary mask depicting RER cisternae in black
and cytosol in white), followed by RER determination using particle analysis on the segmented image (C and
G). Overlay of the binary masks on the TEM images (D and H), RER cisternae in ved, and cytosol in green).
Exemplary percentages of the area covered by the RER cisternae are shown in the top right (CD mouse) and
bottom right (WD mouse.

At the end, solidity (S) was measured using the same Fiji software. Solidity describes
the extent to which shape is convex or concave. Taking the area within the mitochondrion
and dividing it by the area enclosed by a convex hull provides information about the
solidity of the shape (Figure 6C). Solidity of a perfectly convex structure is 1, but when the
structure becomes more concave, the solidity will deviate from 1. The solidity is defined by

area

S=—2 4)
convex area

In the bullet points that follow, we describe each analysis step in detail.
1.Open an image in Fiji.

2. Select the straight line tool from the navigation pane and draw a straight line across
the scale bar. The straight line must be precisely the same length as the scale bar.

3.In the “Analyze” menu, select “Set Scale” When the set scale dialog box opens,
enter the value of a scale bar into the “Knowing Distance” box, and in the “Unit
of length” box, determine the unit of the scale bar from the image. Click the
“OK” button. Now you have set the scale for this particular image.

4.Use the “freehand selection” tool from the toolbar and encircle the first mito-
chondrion on the image. After the right mouse click within the selected encircled
mitochondrion, choose “Add to ROI Manager” from the dialog box.

5.Now encircle the next mitochondrion and click “Add” in the ROI Manager. In the
same way, encircle all the mitochondria in the image.

6.In the “Analyze” menu, select “Set measurements” and thick the desired param-
eters from the dialog box. For the analysis of mitochondria, we selected “Area”
and “Shape descriptors”. Click the “OK” button.
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7.Now everything is set to analyze all the mitochondria from the image. Select “Mea-
sure” in the “Analyze” menu, and a new window with results will pop out. Save the
results by selecting “Save as” from the “File” menu of the “Results” window.

8. Now you can analyze the new image in the same way. Remember that the scale
must be set again when analyzing the next image.

In Figure 4 one can observe the results of the above analysis on mitochondria of
two representative images of the exocrine pancreas from a CD (Figure 4A) and a WD
(Figure 4B) mouse.

5.3.2.2 Analysis of rough endoplasmic reticulum (RER)

Quantitative analysis of the surface area covered by the RER cisternae on TEM
images can provide valuable insight into functional changes in both acinar and endo-
crine cells. Quantification of the TEM data, in general, involves manual annotation
of structures of interest. This approach proved to be an extremely time-consuming
process for quantification of the RER data, as the organelle forms a complex and inter-
connected network of cisternae. To overcome this issue, Trainable Weka Segmentation
(TWS, available as Fiji/Image]J plugin) provides a machine learning tool capable of
automated segmentation [99]. A limited number of manual annotations on a sample
(training) TEM image produces a classifier that can be applied to the remaining data to
segment images automatically. The following pipeline describes steps for RER analysis:

1. Image segmentation: TWS produces a segmented image that reliably separates
RER cisternae from the cytosol (Figure 5B and F, compare with Figure 5A and E,
respectively).

2. Particle analysis: subsequent particle analysis on the segmented image excludes
unwanted objects based on the size exclusion criterion that removes small
objects that were detected mostly within RER cisternae (Figure 5C and G). If
needed, manually delete unwanted objects.

3. Quantification of data: the resulting binary mask improves partitioning compared
to TWS segmentation alone (Figure 5D and H). The resulting image segments al-
low for quantification of RER abundance, expressed as the relative area covered by
RER cisternae (% RER area). This approach detected a large increase in % RER area
in WD mice compared with CD mice in the given cell (42% vs. 18%) (Figure5).

5.3.2.3 Analysis of zymogen granules

Zymogen granules form a reserve pool of digestive enzymes that are secreted from
acinar cells after stimulation. The granules are well visible on TEM images and detect-
ing a change in a number of granules per cell, cumulative granule area per cell, or
granule size could suggest a functional change in their physiology. Manual counting
of granules is the simplest method to quantify zymogen content; however, it relies on
an assumption of typical granule size, and it is a relatively time-consuming approach.
Alternatively, manual annotation of individual granules would provide data also
on the granule size, but it is an even more time-consuming method that would
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Figure 7.

Quantitative analysis of the surface area of zymogen granules. Representative TEM images from CD (A) and
WD (E) mice. Image thresholding and watershed separation produce a binary mask (B and E), zymogen
granules in black, inset depicts exemplary partitioning of two touching granules). Individual granules are
determined using particle analysis on the segmented images (C and G). Panels D and H depict an overlay of
the granules on the grayscale TEM image (vesicles in ved). Quantification of the granule cross-section area
shown in the panel I for a given cell from the CD and the WD mouse. Data were pooled from the following
number of ROIs from the CD/WD image: 35/27. Data were analyzed using the Mann—Whitney U test, p values
ave indicated on graphs.

effectively hamper analysis or limit it to a few cells only. To at least partially automate
the quantification, we took advantage of the fact that zymogen granules have typical
properties: (i) granules are spherical structures, and (ii) they appear electron-dense
(i.e. dark) on TEM images (Figure 7A and E).

The following brief instructions describe a useful procedure to partition the
granules on a TEM image:

1.Image thresholding and separation: Since granules provide good contrast,
thresholding the TEM image produces a rough binary mask of granules. Inher-
ently, the thresholding procedure detects two or more granules in close proxim-
ity as uniform structures. We can reliably separate the touching granules using
the watershed separation method [100]. This method interprets the input image
as a topographical surface that is flooded with water, placing water sources in
the local topographical minima, and placing dams where water from differ-
ent sources meets. These dams constitute the watershed (i.e., a border between
touching granules, Figure 7B inset). The method works best for smooth convex
objects that do not overlap too much, and it efficiently separates granules after
the initial thresholding (Figure 7B and E).

2. Particle analysis: Employ particle analysis to remove unwanted small objects
in the cytosol that were detected with the thresholding. Limiting the minimal
object size effectively removes the background noise (Figure 7C and G).

3. Quantification of the zymogen granules: The resulting binary mask detects indi-
vidual granules (see the overlay in the Figure 7D and H). The segmentation data
generally allow for a straightforward counting of granules, assessing the cumula-
tive granule area (case the entire cell is imaged, example data not shown), and
granule size. The latter decreased by 22% in the analyzed acinar cell from a WD
treated mouse (Figure 71).

13
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Figure 8.

Quantitative analysis of the vacuoles. Representative TEM images from CD (A) and WD (E) mice. Manual
annotation of vacuoles resulted in a binary mask (B and E), vacuoles in black; please note that no vacuoles were
present in A. Panels C and D depict an overlay of the vacuole binary mask on the grayscale TEM image (vacuoles
in red, cytoplasm in green). Percentages of vacuole cross-section areas arve shown on the vight for the CD (blue)
and the WD (red) mouse.

5.3.2.4 Analysis of vacuoles

Cytoplasmic vacuolization is an ultrastructural change associated with pathological
alterations in pancreatic cells [101]. The vacuoles appear electron-lucent (i.e., bright)
and inhomogeneous on TEM images, very similar to other structures, and this does
not allow the use of image thresholding as a technique to effectively detect vacuoles.
Since the number of vacuoles per cell is limited, manual annotation of the structures is
feasible.

1.Manual detection of the vacuoles: Use Fiji/ImageJ in combination with the built-
in ROI manager to outline the vacuoles, which results in a binary mask of the vis-
ible structures on the image (Figure 8B demonstrating an empty mask, since no
vacuoles were visible on the image, and 8E shows several vacuoles that were seen
within a cell). Overlaying the structures can serve as visual feedback for quality
assessment (Figure 8C and F).

Quantification of the vacuoles: Use data from the above step to measure the relative
area covered by the vacuoles by dividing the cumulative vacuole area by the visible
cytoplasm surface. Using this approach, we demonstrated that vacuoles are abundant
in the acinar cell of WD treated mice (27% vs. 0% in WD vs. CD mice, Figure 8 right).

6. Conclusions

There are only a handful of studies on pancreatic exocrine and endocrine
ultrastructure in mice under diabetogenic conditions. One of the reasons for this
relative underrepresentation of such a translationally relevant topic in the literature
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may be the rather complex study design typically accompanying work with genetic
or dietary mouse models and electron microscopy. An even more important reason
may often be a lack of a toolbox to easily, objectively, and reproducibly analyze
ultrastructural changes in exocrine and endocrine cells in a quantitative manner. In
this chapter, we tried to specifically address this problem by providing the readers
with a robust step-by-step approach and detailed instructions on how to quantify
changes in the ultrastructure of mitochondria, rough endoplasmic reticulum, and
secretory vesicles, as well as the presence of vacuoles, by means of shape descrip-
tors, thresholding, manual selection, and machine-learning supported image
segmentation, followed by different quantification steps employed in the open-
source Fiji software. With some field-specific modifications, our analyses shall also
be useful for many other life scientists.
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